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T H E  R I S O G R A P H :

It looks like a photocopier 
and moves as fast as one, 
but works as a screenprint-
er; using rich spot colours 

and stencils to create tactile 
and vibrant prints, afforda-
bly and with little impact to 

our environment.

The RISO works by trans-
forming your artwork into a 
stencil. Your chosen colour 

drum is then inserted into the 
riso machine, and the stencil 
is wrapped tightly around it.

Paper is fed flat through the 
machine, passing under the 
rotating drum, which trans-
fers your artwork onto the 

paper at high speed. 

Stencils are made 
specifically for each drum 
and are non transferable.

One colour is printed at a 
time, and multicoloured 
prints are created by 

switching out drums, then 
over printing; passing the 
paper through the RISO 

again and again!

Masters of the A3; RISOTTO 
produce vibrant prints for a 

range of clients, from leading 
art organisations to bands and 
brands; quickly, & creatively.

Years of gathered experience, 
coupled with in-house produc-
tion allows RISOTTO to offer 

bespoke services with a strong 
focus on design.

So, whether you’re looking to 
print an art edition, master a 

technical print challenge, or get 
posters pimped up - get in touch!
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The process is great for graphic art 
(vector based work), typography, and illustration, 

but also works wonders across painting and 
photography, using variations of CMYK.

For jobs that will require finishing services - 
TRIMMING / BINDING / FOLDING / COLLATING

- we can either offer some services in house, 
otherwise it will be over to you to take the 

A3 prints onto another specialist to be finished.

Risograph printing was originally designed 
for high-volume printing in places like offices, 

schools & political parties, but in the last 5 
years, it has undergone a resurgence with cre-

atives adopting the process because of its 
quick and colourful results at affordable prices.

The riso was designed to bridge the gap be-
tween cheap and expensive print methods 
(from the photocopy to offset/litho), which 

makes it ideal for quantities of 1–2000 prints, 
become most cost effective at 25+ prints.

POSTERS + FLYERS
BUSINESS CARDS

ART PRINTS + EDITIONS
MENUS + PLACE MATS
PROGRAMMES + MAPS

FOLDED CARDS + ENVELOPES 
PAPER BAGS + WRAP

TAPE COVERS + VINYL INSERTS 
STICKERS + SWING TAGS 
ZINES + PUBLICATIONS 

A P P L I C AT I O N S

We can fold A2 paper and feed it through the machine manually - but only for 
small print runs. Extra costs and limitations apply, so get in touch to find out more!

WE PRINT A3
The riso is an A3 printer - so everything is sent on A3 sized 
stencils, and printed on A3 paper. Finishing services can 
be applied to create some of the following applications:



I N K S

INSTALL OUR INK 
SWATCHES TO 

EXPERIMENT WITH ALL 
THESE GLORIOUS 

COLOURS IN YOUR 
ARTWORK

BRIGHT RED U

FEDERAL BLUE 294U

PURPLE 2685 UORANGE 021 U

TEAL 321 U

FLURO PINK 806 U

AQUA BLUE 312 UYELLOW UBURGUNDY 235 U

GREEN 354U

MEDIUM BLUE 286UBLACK U VIOLET 265 U

FLURO ORANGE 805 U

The RISO inks produce a unique texture, 
resulting in a hand-printed and tactile 
finish. 

The inks are soy-based and non-toxic, 
which means they can take longer to dry. 
The ink sits on the surface of the paper 
and can therefore be prone to smudging 
if handled a lot (like newspaper). 
 
All inks are unique to the riso process 
and colours produced cannot be repre-
sented on the web or through digital 
print (especially our fluro and metallic 
inks!) giving you a unique print results. 

We therefore cannot colour match, but 
can offer advise on how you could work 
around this.

Print samples are sent out regularly, as it 
is important that customers can see and 
feel the print results in the flesh before 
printing for the first time.

We update our swatches regularly so 
ask us for the most up to date swatches 
available. 

ADOBE 

SW
ATC

HES

METALLIC GOLD

SPECIAL INK!FLUORESCENT INK! FLUORESCENT INK!



S P E C I A L  I N K S  - M E TA L L I C  G O L D
Unlike the other riso inks, Metallic Gold prints great on 
black and dark paper, as well as white. It has a thicker 
consistency and higher opacity - so keep this in mind if 
using it in overlaid artwork.

As we have a two colour machine, we print two layers 
together in the same pass. The image below shows 
artwork printed in black + Metallic Gold ink. The layers 
were printed with the gold underneath - but the results 
look as though it’s ontop. This is how the metallic gold 
behaves when printed/layered with another colour.  

If you want to avoid this, and let the other ink stand out; 
you could potentially knock out areas where the gold 
overlaps, or reduce the gold percentage to 40-50%. 

GOLD LAYER 
PRINTED 

UNDER BLACK 



Riso inks have a translucent 
quality that work well when 

overlaid and blended with other 
inks. Many more colours can be 

achieved this way.

Examples of orange ink printed onto 
various papers. Please note that ink 

colours can change depending on what 
paper they’re printed on.

Switch on the ‘MULTIPLY’ effect in the Transparency tab 
when designing in adobe to see a mock up of how it will 
print, and download our swatches to integrate our pallet 

into your workspace for further experimentation.

O V E R L AY

WARNING
When producing prints with 

multiple colours/heavy cover-
age, unwanted marks can occur 
by the feed tire, picking up ink 

from the previous print, and 
transferring it onto the next 
sheet of paper being fed. 

These marks can be difficult 
to remove. We therefore recom-
mend no more than 4 passes, 

or 2 when using heavy 
coverage or darker colours.

TOP  T I P S
Use a rubber to remove any tire 

marks or unwanted smudges.

Layout: Leave one area (either 
top or bottom) of A3 sheet clear 

or with little coverage.

+ =

100% 100%

PAPER  +  INK



PA P E R S
RISO inks print well on most uncoated 
papers, as it can be absorbed onto the 
surface and allowed to dry (unlike print-

ing onto coated or trace papers).

WE IGHTS
Generally 80gsm - 250gsm 

is the standard weight 
bracket that the riso will 

respond well too.

We stock tested papers at 
60gsm - 350gsm but these 

can be a little tricky at times 
as they are prone to sticking 
to the stencils or jamming, 
etc. We are happy to use 
them for shorter runs, and 

with low ink coverage.

BESPOKE PAPERS

If you have a particular 
paper request, and the 
quantities are high, we 
can order it in for you.

For lower runs (under 
250 A3 sheets), we 

ask that you organise 
your paper inde-

pendently, as this often 
works out more cost 

effective. 

We’d prefer to test a 
new paper first, so 

please send us a few 
sheets so that we can 
ensure ink drys well, 

& the machine feeds it 
smoothly. 

When ordering, add 
an additional 15% 

extra to the required 
quantities to cover any 

misprints.

Our UK suppliers 
include: GF Smith, 

Fenner, Paperback, & 
Antalis. We carry 

extensive sample books 
in our workshop.

drys

Download our A3 Paper 
Scans to mock up 

artwork and  make your 
paper choices.

Remember - you’re welcome 
to mix and match!

Forrest Green: 120gsm

Pale Blue: 80gsm 

Med Blue: 80gsm 

Dark Purple: 120gsm

Sky Blue: 120gsm 

Pale Green: 80gsm

Green: 120, 160gsm

Purple: 120gsm

Peach: 80, 120gsm

Bright Yellow: 80, 160gsm 

Canary Yellow: 80, 160gsm

Pink: 80, 160gsm

Salmon: 80gsm

Lilac: 80gsm

Tangerine: 80gsm

Iceberg: 80gsm

Dark Grey Glitter: 120gsm 

Tan: 120gsm 

Blood Red: 120gsm

Red: 80, 120gsm

Steel Grey: 160gsm 

Cream: 80gsm

Cyclus: 100, 140, 200, 250, 350gsm 

Cairn White: 120, 320gsm

Munken Lynx: 120gsm, 300gsm

Newsprint: 65gsm

Classic: 80gsm

Super Smooth: 120gsm, 330gsm

Context Ivory: 100, 270gsm

Context Natural White: 150gsm

WHITES : COLOURS :

Fluro Pink: 80gsm

Fluro Yellow: 80gsm

Fluro Orange: 80gsm

Fluro Green: 80gsm

F LURO:

A LTERNAT IVES :

Loop Sandstone: 120gsm

Colorset Nero: 170, 270, 350gsm

Context Sage: 250gsm

Metaphor Cream:120gsm

Metaphor Hairy:100gsm

Parchment Melon: 90gsm

Parchment Pink: 200gsm

Parchment Grey: 200gsm

Parchment Blue: 90gsm

Cairn Dark Grey: 120gsm

Cairn Eco Grey: 140gsm

Cairn Eco Kraft: 170, 270gsm

Marlmarque: 300gsm

Vintage Light Maroon: 120gsm

Vintage Maroon: 120gsm

Loop Granite: 120gsm

Loop Milkweed: 120gsm

Cairn Straw Cream: 320gsm

Charcoal: 100gsm

Dye: 270gsm

Fibre: 100gsm

Hairy: 120gsm

Mute: 300gsm

Tinsel: 100gsm

Petal: 300gsm

Splat 2: 200gsm

Splat 1: 300gsm

Hairy: 120gsm

IND IAN:



BESPOKE PAPERS

If you have a particular 
paper request, and the 
quantities are high, we 
can order it in for you.

For lower runs (under 
250 A3 sheets), we 

ask that you organise 
your paper inde-

pendently, as this often 
works out more cost 

effective. 

We’d prefer to test a 
new paper first, so 

please send us a few 
sheets so that we can 
ensure ink drys well, 

& the machine feeds it 
smoothly. 

When ordering, add 
an additional 15% 

extra to the required 
quantities to cover any 

misprints.

Our UK suppliers 
include: GF Smith, 

Fenner, Paperback, & 
Antalis. We carry 

extensive sample books 
in our workshop.

P R E PA R I N G  F I L E S

SUMMARY
For print, artwork files should be: 

 1. Flattened PDF (no layers or transparencies)
 2. Set to Greyscale / B&W
 3. Resolution = 300dpi  | Size = A3
 4. Each colour layer saved as a separate file

DOCUMENT SIZE: A3 (420 x 297MM)

The RISO cannot print full bleed A3 artwork
Please leave a 10mm clear border on all prints 

All images and content within files must be set 
at the size intended for printing, and 300dpi. 

The risograph will automatically convert your 
images into halftones, so there is no need to 
set bitmaps prior to print.

C O M M O N  G L I T C H E S
C A U S E D  B Y  ‘ E F F E C T S ’
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If your artw
ork contains effects such as drop shadow

s, the riso w
ill 

pick this up and print visible boxes accross your artw
ork. These ele-

m
ents need to be flattened and rasterised before print.



Using Adobe Illustrator:

- Hide, or de-select elements that can remain 
as vectors.

- Select only the elements that are effected, to 
be flattened and rasterised.

- In the ‘Object’ menu, click on ‘Flatten Trans-
parency’

- In the pop up menu, set a custom Preset to 
match the following.

- Finally, in the ‘Object’ menu, click on 
‘Rasterize’ and set it to greyscale + 300ppi.

U
sing A

dobe Photoshop:
- G

o to the ‘Layer’ m
enu and select ‘Flatten Im

age’

- Finally, go to ‘Im
age’ >

 ‘M
ode’ and m

ake sure your im
age is ‘G

reyscale’

 
For Acrobat 7, 8 or later:

1. Make a backup copy of your PDF file.

2. Open your file and choose Advanced > PDF Optimizer. 

3. Click the Clean Up tab OR If asked whether you want to 
save and continue, click Yes 

4. If asked, Select: Discard User Data
Discard Hidden Layer Content + Flatten Visible Layers
and then click OK

5. When prompted, save the Optimized PDF with a new name

6. Open the Layers panel (choose View > Navigation Panels > Layers)

7. Click the Options menu, and select Merge Layers or Flatten Layers

8. Save the PDF file and try to print it.

Merging or flattening 
layers can't be undone. 
So for this procedure, 

use a copy of your PDF.

 Merged layers acquire the properties of the layer into 
which they are merged. Flattening layers discards any 

layer content that isn't visible onscreen.

F L AT T E N I N G  F I L E S  I N  A D O B E . . .
Some PDF files contain layered content + transparencies if they 
are created by using applications such as Adobe InDesign or 
Illustrator. When printing PDFs that contains layered content, the 
riso will read each element uniquely and the printed result won’t 
correlate to the on-screen art. The riso will pick up on these and 
print them awkwardly, resulting in visible corruptions. This is 
why it’s important to Merge / Flatten layers before sending, so 
that all transparencies or effects become part of the artwork.



UNPRINTABLE AREA

PRINTABLE AREA

A3 PAPER

A3

A 3  L AY O U T

DOCUMENT SIZE: A3 (420 x 297MM)

The RISO cannot print full bleed A3 artwork
Please leave a 10mm clear border on all prints 

FULL BLEED POSTERS
For a full bleed finish, we can crop your posters once they’re 
done printing. 

If you’d like to make your poster full-bleed, we’ll need you to 
add 4mm bleed to all sides of the artwork, whilst retaining it 
within the printable area, so no important artwork is lost. 

The cropped poster will be approx. 270 x 393mm in size 

There is no need to add crop marks or registration marks as 
this will only reduce the finished size of your file, by making 
room for them within the printable area). 
  

UNPRINTABLE AREA

BLEED

A3 PAPER

A3

FINISHED ART AREA

BLEED IS EXTRA IMAGE AREA, 
USED TO ENSURE A CLEAN TRIM

This portion of the card will be lost 
when cut to the final size. We use 
it to ensures no white edges are 

left exposed, and the colour, 
image or design continues right to 

the edge of the card.

Keep this area clear of all 
sensitive and important 

information that you don’t want to 
be trimmed of by our guillotine.



C A R D S  +  F LY E R S  L AY O U T

BLEED (4mm)

A5 PRINT 

A3 PAPER

CROP MARKS

A5

A5

REDUCED

A5
REDUCED

A5

REDUCED

A5
REDUCED

A5

5MM BLEED IS REQUIRED ON ANY
PRINT THAT WILL BE TRIMMED TO SIZE 

CROP MARKS SHOULD BE ADDED TOO

UNPRINTABLE AREA 
Although the A4 
spreads are posi-
tioned across the 
full area of the A3; 
there should be no 
artwork or content 
occupying this 
unprintable 10mm 
border area.

A3 PAPER



297m
m

210mm

A4

A4

253mm

179mm

A4
REDUCED

A4
REDUCED

A5

A5

A5

A5
210mm

148mm

171mm

121m
m

A5
REDUCED

A5
REDUCED A5

REDUCED

A5
REDUCED

82mm

121m
m

A6
REDUCED

A6
REDUCED

A6
REDUCED

A6
REDUCED

A6
REDUCED

A6
REDUCED

A6
REDUCED

A6
REDUCED

148mm

105mm

A6

A6

A6

A6

A6

A6

A6

A6

91m
m50mm

BUSINESS CARDS

270mm
393mm

FULL 
BLEED 
TRIM

TR IMMING
OPT IONS
Our guillotine can trim all of the following formats, as well 
as custom dimentions. Just set your crop marks acordingly 
and we’ll trim to match. Measurements may be a few mm 
out due to the nature of the machine, and movements in the 
riso’s registration. N.B. Only the diagrams in lilac require 
crop marks on the page. Download our adobe templates 
for layout guides for all the following formats.



N A M I N G  F I L E S
We need a file for every colour you’d like to print with, 
plus 1 additional file of a full colour digital proof. 

Please specify the colour you’d like the file printed in.
(the name or pantone will do)  

For example, a two colour poster will have 3 separate files: 

Without the proof file we won’t be able to see 
what results you’re anticipating, and therefore 
can’t point out any potential issues or mistakes. 

You don’t need to match the colours exactly, 
It's just to give us an feel for your artwork. 

Peter_Red_A.pdf Peter_Blue_B.pdf Peter_proof.pdf

For double sided artworks, include sides:

1. Peter_Side1_Red_A.pdf     
2. Peter_Side1_Blue_B.pdf    
3. Peter_Side2_Red_A.pdf   
4. Peter_Side2_Blue_B.pdf    
5. Peter_Side1_proof.pdf   
6. Peter_Side2_proof.pdf 

For multiple artworks, include artwork titles: 

1. Peter_Drawing_Side1_Red_A.pdf  
2. Peter_Drawing_Side1_Blue_B.pdf 
3. Peter_Drawing_Side2_Red_A.pdf 
4. Peter_Drawing_Side2_Blue_B.pdf   
5. Peter_Drawing_Side1_proof.pdf 
6. Peter_Drawing_Side2_proof.pdf 

1. Peter_Painting_Side1_Red_A.pdf     
2. Peter_Painting_Side1_Blue_B.pdf 
3. Peter_Painting_Side2_Red_A.pdf  
4. Peter_Painting_Side2_Blue_B.pdf  
5. Peter_Painting_Side1_proof.pdf
6. Peter_Painting_Side2_proof.pdf  

If you are creating artwork with overlays, feel free to indicate 
which layer you'd like printed first (A for first, B for second etc).
 
We generally aim to print the lightest colour first, and dark-
est/heaviest coverage layer last, to reduce track marks, so we’ll 
discuss this with you if it conflicts with your desired order. 



O PA C I T I E S
All files are sent to the printer in grayscale, and colours 
are added within the printing process.

To print solid areas of colour, artwork should be set to 
registration black, which is often indicated by the 
cross-hair symbol and can found in SWATCHES panels:

The riso is very sensitive and will register different shades 
of black which will be visible in the printed output. 
So please insure all tones of black have the same settings 
if you intend their output to be the same. 

The different opacities of  greyscale, are represented as 
different opacities of your chosen colour:

ARTWORK: RED PRINT:

PRINT RESULT

ARTWORK FILES 
FOR PRINT

Peter_Red_A.pdf Peter_Blue_B.pdf 

100% 
BLACK

20% 
BLACK

50% 
BLACK

100% 
BLACK

50% 
BLACK

100% 
LILAC

50% 
LILAC

100% 
BLACK

20% 
BLACK

50% 
BLACK

This is especially 
important for text under 
12pt, as in other settings 
it will appear pixelated! 

Sometimes simply changing the 
document settings to ‘greyscale’ 

in photoshop for example, 
might not always be sufficient. 



I N K  C O V E R A G E

Large areas of solid 
colour can also cause 
problems! Especially 
around the edges and 
top/bottom of stencil 
(keep one end clear)

The riso can’t print 
100% ink density 
across 100% of the 
paper.

Too much ink coverage can cause paper to stick to the sten-
cil/drum, which can jam the machine and tear up the paper. 
This will stop us being able to print, and will require the art-
work to be amended by you, and a new stencil to be sent - 
costing £10 per colour.

Heavy ink can also cause extra splashes, needle marks and 
smudges on prints, as the paper is separated at an uneven 
rate. Large areas of ink set between 90-100% can result in a 
visibly varied print consistency due to ink flooding across the 
stencil.

Track marks from the feed 
tire can appear when 
prints make multiple 

passes. Marks can also 
appear on double sided 
prints, from pressure im-

pressions that can mark the 
next sheet of stacked paper 
if there is ink in this area.

*If marks do appear, 
most can be minimised 

with a rubber!

*

70%

75%

100%
Solid Ink

85%
Opacity

NEEDLE MARKS 
(looks like a scratch)

75%  
BORDER

100%  
BORDER

85%  
BORDER

PRINTING heavy bor-
ders around the edge 
of the page will not 
work.The paper will 

stick to the drum due to 
the amount of ink 

around the lead edges.
Either reduce the opac-
ity to 75%, or create 

blocks to stop the 
border at both lead 
ends of the page.

75%

PLEASE NOTE:
These correct 

layouts may still 
have a chance 

of needle marks.



*On exiting the machine, prints stack 
on top of each other: If the artwork is 
ink heavy, it can mark (create an echo 
on) the reverse of the prints.

If you require a cleaner finish, you can 
request that we intersperse prints with 
blotting paper at an additional cost.

Reduce the chances of ink transfer, 
and ensure a cleaner print:

• Print using 50% coverage across 
the entire page.  

• Avoid large areas of ink at the 
paper feed area. 

• Limit the number of inks (passes 
made through the machine) 

• Reduce large areas of solid ink 
to a 70-85% tint

• Ask to have your prints ‘Blotted’*

We can advise you 
further if we feel you 
artwork might suffer 
from ink coverage

TOP T I P  
Opt for thicker 
paper when 
printing with 
lots of ink!

I N K  C O V E R A G E  These issues are especially 
important to note if prints 
are double sided or have 

multiple layers.

We often recommend 
inverting artwork, or 

using a coloured paper 
instead of printing a 

coloured background.



G R A D I E N T S RISO doesn’t print 0-10% ink well..

This is mainly an issue when printing 
gradients as the range is very visible. 
For best results - set gradients to range 
between 10%-90% ‘K’ (black). 

For Photography that has large 
areas containing 0-10% 
content, results can look 
better if the lightest part is 
increased to 10%. This will 
prevent the unappealing 
‘drop off’ that happens 
between 0-10%.

Setting your darkest tone to 90% is only nec-
cessary for large areas of ink coverage. Set-
ting it to 90% won’t visibly change the ap-
pearance much, but will avoid any ‘tide’ 
marks or flooding appearing. These are 
visible inconsistencies accross the surface.



T E X T  /  T Y P E
Text always prints best when set to using registration 
black and in vector form; which is created when 
working from Illustrator or InDesign. 

Use normal black (100% K) for type 14pt or above to 
avoid excess ink. 

Never create type in Photoshop, as it rasterizes it as an 
image, and the printed result looks rough around the 
edges instead of being clean and crisp.

To keep text & line art as vectors when exporting 
artwork; do not rasterize. 

Minimum (recommended) text = 7 PT (reg. black only)
Line Thickness minimum = 0.25 PT (reg. black only) 

The machine will struggle to accurately reproduce type 
smaller than 6pt & we would recommend sticking to 7pt 
and above. Smaller text will also have legibility issues.

For Knock-out text, do not 
set type below 8pt. The 
printer isn’t reading it as 
text, but rather the pixels 
around the text, so be 
careful with percentages 
of colour: if surrounding 
ink is too wet/ heavy, it 
can flood the text gaps, 
and too pale can result 
in jaggy edges.



Increasing the width/borders on 
graphics will help layers overlap 

and ensure a full colour fill.

USE TRAPPING

C M Y K  E F F E C T:
The CMYK printing process can be imitated on the 
riso; by using the yellow and black as normal, and 
substituting the Magenta for Fluro Pink and Cyan 
with our Blue. Alternatively other inks can be substi-
tuted to create your desired pallet depending on 
how vibrant you’d like the output. 

We have invested a lot of time and expertise in this 
area, and can separate artwork for you - ready for 
the 4-colour process - at a flat rate of £30 per A3. 

S T E N C I L S
Switch on the ‘MULTIPLY’ effect in the Transparency 
tab when designing in adobe to see a mock up of 
how your layers will print.

Download our swatches to integrate our ink pallet 
into your workspace for further experimentation.

PINK.pdf TEAL.pdf ORANGE.pdf 
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TOP  T I P  
When printing 

images, open up the 
mid-tones and ensure 
there is good contrast 

throughout.

There is no need to 
apply the halftone 

effect to your artwork 
as the riso will do 

this for you.



O V E R L AY  S T E N C I L S             C U T O U T  S T E N C I L SOR

BLUE.pdf PINK.pdf GOLD.pdf 
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I M P E R F E C T I O N S
Riso printing doesn’t suit every job due to it’s unique 
results, so being open to the quirks of the machine is 

an important part of printing with us.

The best outputs are usually designed with the riso 
process in mind from the start, rather than re-working 

artwork afterwards (although not in every case!).

As the riso isn’t perfect like a digital printer; your 
finished prints will have a different look and feel to 

what you see digitally on your computer screen.
Our soy inks have similar qualities to newspaper ink, 
and can smudge if handled a lot, and each print will 
differ slightly from one to another, with small imper-

fections in registration and ink coverage.

All these quirks can be minimised by following our 
print guide and finally, neatened up at the end with 

the help of a rubber! 

PR INT  MARKS

There will be print marks, 
especially when printing 

more than two layers, 
artwork that uses heavy 
ink, and/ or is double 
sided. Generally, the 

cleanest, crispest prints 
are; one colour, have light 
coverage, and printed on

mid-weight paper.

T IRE  MARKS

When producing prints with 
multiple colours, unwanted 
tire-marks can occur by the 

feed tire picking up ink from 
the previous print, and 

transferring it onto the next 
sheet being fed. When pro-
ducing double sided prints, 
pressure marks caused by 

ink transfer can also occur if 
there is ink in this area.

NEEDLE  MARKS

A ‘pick off needle’ is used 
within the riso to peel off 

the print from the print drum 
when printing. Heavy ink 
will cause the needle to 

drag across the print leav-
ing a scratch line.

Depending on the artwork, 
their visibility varies.

REGISTRAT ION

As each colour is printed 
one layer at a time, registra-

tion will never be 100% 
accurate, so when design-
ing your artwork, ensure 
there is room to allow for 
2-3mm shifting. Extend 

colour under line work for 
neater results, use trapping 
to avoid white spaces, and 
avoid small details that rely 
on registration to be 100%

INK

When printing large areas 
of solid colour - the outcome 
can appear Inconsistent in 

coverage. Some ink discrep-
ancies are unavoidable and 
are an inherent part of the 

printing process.

USE TRAPPING

DOUBLE  S IDED PR INTS

Light marks will appear 
when printing double sided, 

especially if one side is 
heavily inked, this is caused 
by the pressure roller. We 
will always print the side 
with the lighter coverage 

first. The internal rollers can 
cause extra marks from pick-
ing up ink from preprinted 

image. We recommend 
having one side with lighter 

coverage.

INK TRANSFER

Prints are stacked on top of each other when 
they come out of the Riso so heavy ink will 

cause transfer between the prints. Guillotining 
applies extra pressure and can also create 

additional transfer marks. We offer an addi-
tional service to intersperse blotting sheets in 

between prints as they come out. This keeps the 
reverse side super clean. Riso ink can smudge 
easily so is best to avoid having large areas of 
solid colours for flyers and book covers. Use 
spray fixatives on prints with heavy coverage 

to helps to minimise smudging. 
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RISOTTO takes great care in minimizing its 
impact on the environment; from daily studio 
operations, to waste management, and sus-
tainable paper supplies. We up-cycle test 
prints/leftovers, and recycle everything else. 

Riso printing in itself is a highly energy effi-
cient and sustainable printing method, making 
for an ethical product, unmatched by other 
printing methods. 

The cold process consumes little energy, and 
the riso prints with soy based (non-toxic) inks, 
and stencils made from plant fibres. Unlike 
litho printing, it only takes a single print for 
the stencil to be fully inked and ready to print. 
It uses little electricity and eliminates the need 
for up to 100,000 litres of water and 10,000 
litres of alcohol (per year) consumed by a 
typical mid-size printer. 

We make all of our paper goods in our 
zero-waste studio in Glasgow, keeping 
our transportation costs and fuel con-

sumption to a minimum, and reinforcing 
our commitment to sustaining the power 

of small-scale artisan quality, as an 
alternative to mass production.



A M E N D M E N T S
Once printing has started, there will be a £10 fee for 
every new stencil or amendment made.

Please make sure you’ve read through our print guide 
and terms thoroughly before going ahead with printing.

Sometimes, we can’t see any problem with your file until 
it’s been printed. Usually this is because file has not 
been flattened properly, small text has not been set to 
registration black or text has been done in photoshop - 
and it appears pixelated. 

These issues are your responsibility to check and correct, 
and we cannot be held liable for this artwork set up.

TURNAROUND T IMES
Riso printing takes more time than you’d imagine. It’s fast once 
things are set up and running, but unexpected issues (like techni-
cal failures or paper jamming) happen on occasion, and slow 
everything down. Print checks, drying time and alignment are 
also important to us, so we take time to produce the best prints.

So, the more layers you print the longer it takes.

Also - we’re closed weekends!

If you’re tight on time, we can speed things up by shortening 
the drying time between layers, but this can result it addition-
al print marks, so consider this when proposing deadlines.
Our Blotting Service (Extra paper interspersed to soak up 
extra ink and separate prints from one another) can also 
speed up drying time.

Ordering in specific paper will add roughly 5 working days.

NEXT D
AY PRINTIN

G

1 colour prints take 24 hrs.
Add 24 hrs for each additional
stencil, to calculate an
approximate turnaround time.



P R I C I N G
Quotes are calculated 
first by the number 
of colours/stencils used, 
then with print quantity 
and paper selection 
added on the end. Like 
screenprinting, the initial 
set-up is where most of the 
production time is spent, 
and cost is weighted. 

Therefore the most 
economical jobs are ones 
that use few colours/ 
stencils but output high 
quantities, and the more 
expensive jobs involve 
many colour stencils, 
at a low print quantity. 

ZERO RATED
-  Book s
 -  Book l e t s

 
-  B rochu re s

 
-  Ca ta l ogue s

 

-  D i r e c t o r i e s

 

-  F l y e r s  

 

-  J ou r na l s

 

-  Magaz ine s

 

-  Manua l s

 

-  Maps
-  Shee t  Mus i c
-  News l e t t e r s
-  Newspape r s
-  Pamph l e t s
-  P r i c e  l i s t s
-  T ime tab l e s

VATABLE
-  Accep tance  ca rd s

 

-  Bu s i ne s s  ca rd s

 

-  Ca l enda r s

 

-  Ce r t i f i ca t e s

 

-  Comp l imen t  s l i p s

 

-  Coupons

 

-  De l i v e r y  no t e s

 

-  D ia r i e s
-  Fo l de r s

 

-  Fo rms

 

-  I n v i t a t i on s

 

-  I n vo i ce s

 

-  L abe l s
-  L e t t e r heads
-  Po s t ca rd s
-  Po s t e r s
-  Ques t i onna i r e s
-  S t a t i one r y
-  S t i c ke r s
-  T i c ke t s
-  Tran spa renc i e s
-  Envelopes

VAT does apply to 
some printed products, 
but not all of them. 

VAT is charged when 
a VAT-registered 
business sells to 
another business, or 
a non-direct customer.

Here are two basic 
lists of what printed 
products carry VAT 
and which do not. For 
a full list of printed 
items and their VAT 
status please visit the 
HMRC site.

VAT
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No. of Prints

1
 

2
 

3
 

4
 

5
 

6

1 50 100 250 1000

The riso is designed to be a 
duplicator - so once the art
work is set up, it’s pennies 

per print. Also - please note 
that no run is too small, and 

we often print one-off’s!

£75
= 500 x 1 colour
= 250 x 2 colour
=  75 x 4 colour

Printed on our 85gsm newsprint (house stock) | ex. VAT

PRICES
 S

TA
RT

 FROM

:

£15



WHAT SERVICE LEVEL WOULD YOU LIKE?

RECOMMENDED IF YOU:

...have printed before
...are on a budget
..are a RISO Pro

We’ve worked hard to tool you up with the 
most comprehensive riso guides out there; 
so if you’re willing to do your homework, 
you won’t have to pay for anything you 

don’t need. 

By printing with this option, you take full 
responsibility of the print outcome. You 

have read and understood all aspects of 
our print bible, and have set up your art-
work according to our specifications. We 

won’t need to check the files, and will send 
them straight to print.

NO EXTRA COSTS

Remember - if the print isn’t successful (too 
inky, file too big, glitches appear) we’ll 

notify you and ask that you send amended 
stencil(s); costing £10 each. The artwork 

files are still your responsibility to fix.

Our customers’ needs vary, so we’ve tiered our prices to offer the right level of service to suit you.

B A S I C
PAY THE LOWEST PRICE

RECOMMENDED IF YOU:

...have never printed before
...prefer to have a safe riso-ride

...are not sure, and want our expertise

We’ll take the pressure off by talking 
through, checking and digitally proofing 
your files. Avoid any disappointment or 
risk as we’ll clean, flatten and optimise 

artwork for print. 

We won’t tweak any aesthetical elements 
without discussing it with you first. If we’re 

concerned about anything, we’ll talk 
through our options to ensure the best print 
result. This option guaruntees your files will 

be in the optimum format for print.

FLAT FEE = £8 per layer 

S E C U R E D
RISOTTO PRINT GUARANTEE

RECOMMENDED IF YOU:

...don’t have access to Adobe
...want to print complex work

...don’t have time to separate it yourself

We have years of experience re-producing 
high quality artwork for riso print. Our 
skills include separating ‘CMYK’ photo-

graphs and creating duo-tone artworks in 
any colour cobination. 

This separation service will also ensure 
your artwork is output to it’s full potetial.

1 colour print = £22
2 colour print = £30
3 colour print = £38
4 colour print = £45

For bulk artwork set up services (for books 
etc) we offer reduced rates.

We require the high quality A3 artwork; 
PDF, TIFF or PSD. Specify the inks you’d 

like to use, or ask us to advise. 
This service does not include design.

P R E M I U M
FULL ARTWORK SET-UP



Q U O T E S

A3 PRINT QUOTE
Number of colours on SIDE A: (e.g 3 colour)
Number of colours on SIDE B: (e.g 0/Blank)
Copies: (e.g 250) 
Paper: (e.g 120gsm cairn white) 

E X T R A S
The riso is an A3 printer - so 
everything is sent on A3 sized 
stencils, and printed on A3 paper.

As the complexity of all print jobs 
vary, we have no rigid price list 
and we quote based on each job 
individually.

If you can provide details of the 
following - we'll get back to you 
with accurate estimates:

Regardless of the final product, all quotes 
are generated from the A3 pricing struc-
ture, so if you want to know the price for 
50 A4s, we’ll quote for 25 A3 prints + trim-
ming. The A4 prints should be laid out 2UP 
per A3 sheet. Use our adobe templates to 
ensure best results.

FAST TRACK = £15
If you need your job ASAP, we can 
work extra to turn it around faster.

BLOTTING
If you require a cleaner finish, opt for our blotting service. Each print is interspersed 
with blotting paper, separating wet prints from one another, helping to soak up 
extra ink, and speeds up drying time. This process keeps the reverse side super 
clean, which is recommended for prints with heavy coverage. Prices dependant on 
quantity.

PRINT PROOFING:
Due to the RISO process, print proofs aren't common because most of the overall 
job cost is in the initial ’stencil making’ and set-up of the job. A proofing service 
therefore involves a fee of £10 per colour stencil tested. Please bare in mind this 
process will incur additional turnaround time, as the proofs will either be posted out 
to you, or a timetabled appointment will be set for you to come in to see the prints 
first hand. For very large or colour critical orders, we recommend opting for a print-
ed proof, as this is the best way to ensure expected results.

HIRE A DESIGNER:
We specialize in connecting our clients with vetted riso-design talent to help bring 
your print projects to fruition. Tell us all about your project, and we’ll review your 
information and pair you with a hand-selected designer who will work to bring your 
vision to print.

USE OUR DESIGN TEMPLATES:
Select from a range of templates and styles for quick and beautifully printable post-
ers, business cards and stationery. View the current range online.

DELIVERY
Local pick up = Free 
UK Recorded = £10
EU Recorded = £18 
Rest of World = £30 


